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How to Make Best Use of the Manuals

Describes operating procedure from set up and 
software installation to scanning and 
confirmation of operation. Please read before 
using the scanner for the first time.

Printed Manual CanoScan D646U

Quick Start Guide

Detailed information on how to use 
Canon Plug-in Module CS-U.

Canon Plug-in Module CS-U

User's Guide
Electronic Manual

Describes handling and care of the scanner, 
and introduces the accompanying software 
programs.

CanoScan D646U

Product Guide
Electronic Manual

Tells you how to use ArcSoft PhotoStudio 2000 
and ScanSoftr OmniPage SE.

Electronic Manuals Manual for Each
Application Software

When using the 
accompanying 
application 
software.

After you have read this book and mastered 
the use of Canon Plug-in Module CS-U and 
CanoScan Toolbox...

When you open the box

Detailed information on how to use 
CanoScan Toolbox.

CanoScan Toolbox

User's Guide
Electronic Manual

This G
uide
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How to Use this Guide

This guide explains the operating procedures for Canon Plug-in Module CS-U
(hereafter referred to as Plug-in Module CS-U), the Macintosh driver (plug-in
software) used with Canon image scanners.
A plug-in is not an independent software program; it must be used within a plug-in
compliant application, such as CanoScan Toolbox or ArcSoft PhotoStudio 2000, to
expand the capabilities of that program. Adding scanning capabilities to your
computer is as easy as putting in a plug. Simply copy the Plug-in Module CS-U files
to your computer.
Please read this guide to perform the installation procedures and scan. Store this
manual in a handy location for future reference.

Where to Look
Quick Start Instructions   p. 10

The Quick Start Instructions provide a brief summary of commands and
procedures that will assist in using Plug-in Module CS-U immediately.

Scanning Preparations (Required Reading)   p. 13
All users should read this section. This section describes the procedures and
settings required before scanning, including positioning the original and
selecting the output device, resolution, magnification and scanning mode.

Scanning (Required Reading)   p. 29
All users should read this section to learn the procedures for scanning images
and saving scanned images.

Adjusting Scanned Images   p. 35
Read this section for details about how to adjust image brightness, color
balance and other attributes. You can read this section as required.

Appendices
Read this section for troubleshooting tips, glossary terms and the index.

About the Conventions Used in this Guide
The following conventions are used in this guide to draw your attention to
important information.

Caution:
This symbol is used to highlight procedural precautions and limitations.
Always read these topics to avoid errors.

Hint:
This symbol is used to present helpful hints and supplemental information.
Reading these topics is recommended to enhance your enjoyment of
Plug-in Module CS-U.
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Installing Plug-in Module CS-U

Please install Plug-in Module CS-U with the other application programs
according to the instructions in the “Install the Software” section of
“Using the Macintosh Platform” of the Quick Start Guide supplied with
the scanner.

Operating Environment
Hardware

• Power Macintosh, iMac, PowerBook or iBook with built-in USB ports
(performance on Macintosh compatibles is not guaranteed)

Main Memory
• 32 MB or more (64 MB or more recommended)

Application Software
• CanoScan Toolbox
• ArcSoft PhotoStudio 2000
• Other plug-in compatible application programs

Display
• 32,000 colors or more

System Software
• Mac OS 8.6 - 9

Caution
• The ColorSyncTM Profiles file is installed along with Plug-in Module CS-U.

ColorSyncTM Ver. 2.0 or higher is required to use these profiles with the
automatic color matching system (p. 49).

• The following display profile files are available: CANON gamma 1.5
monitor, CANON gamma 1.8 monitor and CANON gamma 2.1 monitor. If
you wish to adjust the color balance of the display, double-click
[ColorSync™] in your Macintosh’s Control Panels folder and select one of
these display profiles.
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Control Panel Features

When you need more information about a control panel button or menu, refer to
the illustration below and go to the referenced page number for more details.
• The illustration may differ slightly from the version of Plug-in Module CS-U

provided in your package.

Hint
In this guide, menu items are marked in the following manner:

Select [Load] from the [Setting File] menu.

➜ p. 49

➜ p. 36-48
➜ p. 51
➜ p. 50

➜ pp. 25-28

➜ p. 52

Tone Adjustment Button
➜ pp. 36-48

Close Box
➜ p. 14

Scan Mode
➜ p. 21

Zoom In Button
➜ p. 31

Zoom Out Button
➜ p. 32

Output Device
➜ p. 18

Resolution
➜ pp. 19-20

Magnification
➜ pp. 19-20

Image Size
➜ pp. 19-20

Required/
Free memory

➜ p. 21

Browser Button ➜ p. 23

Scan Button ➜ p. 33

Preview Button ➜ p. 17

Preview Window ➜ p. 14, 26

RGB values
➜ p. 14

Auto Tone Adjustment Button ➜ p. 36

Rotation Button ➜ p. 24
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Scanning Procedures

Follow these procedures to use Plug-in Module CS-U.

S T E P  2

S T E P  1

Is the scanner attached?

Prepare for Scanning  ➜ p. 13
• Position the Original

• Preview
• Select the Output Device

• Set the Resolution and Magnification
• Set the Scan Mode

p. 16
p. 17
p. 18
p. 19
p. 21

• Set the Scan Area
• Zoom
• Scan

• Save Scanned Images

If the current brightness
and color pose no problem,
there is no need to adjust
these settings.

Scan  ➜ p. 29

  Adjust and Edit Scanned Images
           ➜  p. 35

Verify the Image before Scanning
(Browser Window)  ➜ p. 23

Are the Brightness and Color Satisfactory?

p. 30
p. 31
p. 33
p. 34

• Histogram
• Tone Curve

• Brightness and Contrast
• Color Balance
• Gamma Value

• Threshold Value
• Auto Tone (ColorSyncTM)

• Unsharp Mask
• Descreen

p. 37
p. 40
p. 43
p. 45
p. 46
p. 48
p. 49
p. 50
p. 51

Is Plug-in Module CS-U installed?

S T E P  3

Refer to the scanner's 
Quick Start Guide to 
attach it.

Refer to the scanner's 
Quick Start Guide to 
install it.
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Plug-in Module CS-U Special Features

• See the Results of Adjustments Immediately (Dynamic Preview)
Once in preview mode, the results of adjustments to scan mode settings and colors
are promptly reflected in the preview image.
Highly detailed adjustments can be performed easily because you can see the
results of your changes as they are executed.

• ColorSync™ (Ver 2.0 +) Compatible for Auto Tone Correction
Compatible with the Mac OS 8.5 ColorSync™ (Ver 2.0 +) color management
software. This function automatically matches the color profiles of various devices,
such as scanners, color displays and color printers, for optimal color reproduction.

• Browser Function Permits Confirmation of the Real Image
Before Scanning

The Browser function lets you check the image to be scanned in detail before
commencing the scan. This function presents a much higher quality image than the
preview function.

• Histogram Function Realizes Beautiful Contrast
Simple operation allows you to achieve beautiful contrast with half-tone
gradations.

• Gamma Curve Adjusts Image Brightness
The Gamma Curve feature provides four methods you can use to refine in detail
the level of image brightness until you are satisfied with the results.
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Quick Start Instructions

Folow the procedures below to start scanning immediately. If you require more
information at any stage, read the pages referenced at each step.

Install Plug-in Module CS-U
This step is not required if you have already installed Plug-in
Module CS-U following the instructions in the Quick Start
Guide.
1. Place the CanoScan Setup Utility CD-ROM into the

computer's CD-ROM drive. The CanoScan Setup Utility will
start automatically. (If it doesn't, double click the [CD-ROM]
icon, followed by the [setup] icon.)

2. Click [Install the Software] to install Plug-in Module CS-U and
the other application programs.

Start Plug-in Module CS-U    p. 14
1. Start ArcSoft PhotoStudio 2000 or other plug-in compatible

application.
2. Open the [File] menu, select [Acquire] and [CanonPI CS-U

4.0.0...].

Position materials for scanning and preview them.
 p. 16

1. Position an item on the document glass (platen).
2. Click the Preview button.

• The entire scanable area of the document glass will be
previewed and displayed in the preview window.

11

22

33
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Set the Scan Mode, Output Device, Resolution and
Magnification   pp. 18-22
• Scanning mode determines how the image is scanned (p. 21).
• Output device setting optimizes the images for particular uses (p. 18).
• Resolution determines the amount of detail in the scanned image

(p. 19).
• Magnification determines the amount of enlargement or reduction

of the output image display (p. 19).

Verify Image Quality with the Browser Function before
Scanning   p. 23
1. Click on the [Browser] button.

• The selection frame will appear.

2. Move the selection frame to specify the area of the image
you want verified and click the mouse button.
• Plug-in Module CS-U will read the image and display the

browser image.
3. After you have examined the browser image, click the mouse

anywhere.

Specify the Area of the Image to be Scanned   p. 30
Select the area to be scanned by clicking and dragging the
mouse pointer over the image.
• You may find it convenient to use the zoom feature to select

small areas or to select specific scan areas with precision (p. 31).

44

55

66

➟

Selection Frame
The selection frame moves with
the mouse pointer.



12

Scan the Image   p. 33
Click on the [Scan] button.
• Plug-in Module CS-U will scan the image.

• When the scan is complete, the Plug-in Module CS-U control
panel will close and the scanned image will appear in the
ArcSoft PhotoStudio 2000 or other plug-in compatible
application window as an “Untitled” file.

Save the Scanned Image   p. 34
Save the image with ArcSoft PhotoStudio 2000  or other plug-in
compatible application, specifying a folder and file name.

88

77

➟
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S T E P  1

Scanning Preparations

Step 1 presents the essential preparations for scanning.

The following procedures are explained on the indicated pages.

■  Displaying the Plug-in Module CS-U Control Panel   p. 14

▼
■  Positioning Originals   p. 16

▼
■  Previewing   p. 17

▼
■  Selecting the Output Device   p. 18

■  Setting the Resolution and Magnification   p. 19

■  Setting the Scan Mode   p. 21

▼
■  Verifying the Image Before Scanning   p. 23

■  Rotating the Image   p. 24

■  Setting Preferences   p. 25
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S  T  E  P    1

Displaying the Plug-in Module CS-U Control Panel

The Plug-in Module CS-U control panel is used to perform scans. Plug-in Module
CS-U can be opened from CanoScan Toolbox or ArcSoft PhotoStudio 2000 and
other plug-in compatible application programs.
To quit Plug-in Module CS-U, click on the close box at the top left of the control
panel.

Menu Bar
Click on any menu item to display
more options in a pull-down menu.

Adjusts the settings for the scanning job such as the scan mode,
output device, resolution and magnification.

The image size and disk size that were
specified in the preview window are
automatically displayed here.

Preview Window
Displays the image in preview mode.

Buttons
Click the appropriate button to zoom, rotate or browse the image
or correct colors, adjust the histogram or start the preview or scan.

Close Box
Quits Plug-in Module CS-U.

RGB Values
Displays the R, G,and B values at the
current cursor position (pre-adjusted
value/post-adjusted value)
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S  T  E  P    1

Operating Procedures
The following provides an example of scanning from within ArcSoft PhotoStudio
2000.

Verify that the scanner is attached to your computer and that the power
is on.
Read the Getting Started guide for instructions on how to connect the scanner.

Start ArcSoft PhotoStudio 2000.

Select Plug-in Module CS-U from within ArcSoft PhotoStudio 2000.
Open the [File] menu, select [Acquire] and [CanonPI CS-U 4.0.0...].

The Plug-in Module CS-U control panel will display.

Caution
• Plug-in Module CS-U is not a stand-alone application program. It must be

started from a plug-in compatible application program, such as CanoScan
Toolbox or ArcSoft PhotoStudio 2000.

• The size of the Plug-in Module CS-U control panel will vary according to
the resolution of the computer display.

• The size of the control panel can be adjusted with the [Preview
Window...] option in the [Preferences] menu (p. 26).
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S  T  E  P    1

Positioning Originals

Place the original you intend to scan on the scanner's document glass (platen).

Procedures

Place the original on the scanner's document glass.
Open the cover and set the original face down on the scanner’s document glass
with the top edge at the front of the scanner. Align the original’s corner with the
alignment mark.

Close the cover carefully so the original does not shift out of position.

Caution
• Be careful not to dirty the document glass when placing items on it.
• If an original has distinct horizontal or vertical lines, you should try to

position it on the document glass as squarely as possible to have the lines
appear straight.

• The maximum scanable size is the area of the entire document glass.
• Straighten out curls or folds in originals before placing them on the

document glass.
• To scan right to the edges of an item, position it approximately 2 mm

away from the edges of the document glass (platen).

Alignment Mark

Top Edge
of the
Document

Bottom
Edge of the
Document
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S  T  E  P    1

Previewing

The preview scan is a trial scan performed before the final scan that encompasses
the entire scanable area of the document glass. The preview image is shown in the
preview window. Use this image to specify a scan area and adjust the scan settings
for the image.

Operating Procedures

Click on the [Preview] button.
• The image will be scanned and appear in the preview window.

Hint
• To change the size of the preview window, use the [Window Size] settings

in the Preview Window Settings dialog (p. 26).

Caution
• The Dynamic Preview function enables changes to settings, such as the

scan mode and brightness, to be immediately reflected in the preview
image.

• Nevertheless, the preview image provides only an approximation of the
scan and the final results may differ to some degree from it.

• Calibration automatically starts when [Preview] or [Scan] button is clicked.
Do not lift the document cover while calibration is in process.

➟

When the amount of light of the lamp inside the scanner is insufficient, the
message “Now adjusting lamp…” may be displayed. Wait as is, until the
amount of light increases enough. If you click the [Cancel] button in this
dialog, the preview scan will be executed with insufficient amount of light, and
the previewed image will not have the correct color balance. Click the [Cancel]
button only if you need to obtain the previewed image quickly although
without the correct color balance, before the amount of light is sufficient.
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S  T  E  P    1

Selecting the Output Device

Use the following procedures to select the output device (printer, etc.) for the
scanned image. Select the device that corresponds best to your output device and
use of the image.

Operating Procedures

Click the arrow on the [Output Device] section of the control panel and
select a device from the pop-up menu.

Caution
• You can set the device categories in the pop-up menu in advance. You can

also add new devices to the pop-up menu. See Setting Preferences (p. 25).
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S  T  E  P    1

Setting the Resolution and Magnification

The magnification of an image can be changed before scanning to accommodate
reproductions that are larger or smaller than the original. The settings can be
changed in increments of 1%.

Changing the magnification setting causes the resolution display on the control
panel to change correspondingly. This resolution setting is referred to as the
“scanning resolution.”

Output Device Resolution= 720 dpi, Magnification= 100%

Scanning at 200%

Scanning at 50%

12"/30cm

3"/7.5cm

2"/5cm

6"/15cm

4"/10cm

8"/20cm
Scanning with horizontal/
vertical 2x magnification

Scanning with horizontal/
vertical 0.5x magnification

The scanning resolution changes
accordingly.

Magnification
changed to

50%Magnification
Scanning Resolution

➟ ➟

Magnification
50%

Scanned at
360 dpi

Image size = 5"x5"
(12.7 x 12.7cm)

Image size = 2.5"x2.5"
(6.35 x 6.35cm)

Output device
corrects to

720 dpi

Hint
Magnification and Resolution
Why does the image size change with the magnification? Let us answer this
with an example using a “BJ (720 dpi)” output device. If you were to scan
an image with this device setting and set the magnification factor to 50%,
the scanning resolution will automatically change to 360 dpi. At this
setting, the image will be scanned at a resolution of 360 dpi and the output
device will convert this to 720 dpi, shrinking the size of the output in the
process because it will only have half the data with which to fill the space.
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S  T  E  P    1

To Set the Magnification Factor

Set the desired magnification factor on the control panel.

Hint
The Relationship Between Data Volume and Scanning Resolution
The higher the magnification and scanning resolution settings, the greater
the file size of scanned images. There are certain inconveniences associated
with large data volumes, such as longer processing times and the risk of
running out of memory resources. You are advised against setting the
resolution higher than necessary. For example, if you scan an A4 (21.0 x 29.7
cm (8.3 x 11.7 in.)) size image in the color mode, the amount of data varies
according to the resolution.

Slider
Drag the slider bar in either
direction or use the arrow
keys to change the resolution.

Click here to return the
magnification factor to 100%.

Click inside these boxes
to enter values directly.

Click the up or down arrow to
increase or decrease the
setting.

A4 color image

1.6MB

75dpi

6.3MB

150dpi

408MB

1200dpi

102MB

600dpi

25.5MB

300dpi

* These numbers are approximate and may differ from actual scan results.
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S  T  E  P    1

Setting the Scan Mode

When an image is scanned, it is read as a collection of “dots.” The scan mode that
is selected determines how each of these dots is represented in the output. The
following four scan modes are available.

Black and White
Expresses images in two colors only: black or white. A dot is expressed as either
black or white according to its brightness level and the value set as the threshold
value, which can be freely set. Select this mode to output to a monochrome
printer.

Grayscale
Expresses images in 256 shades of gray. Select this mode to scan black and white
photographs or create monochrome images from color images.

Color
Expresses each color channel (RGB) in 256 shades (8 bit). Select this mode to scan
standard color photographs.

Hint
Scanning the same image in the four different scan modes produces
different file sizes. By size, black and white mode requires the least disk
space, followed in order by the grayscale and the color modes. Before
scanning, check the data volume indicated on the control panel.

The numerator indicates the amount of
disk space required for the scanned image
while the denominator indicates the
amount of disk space available. When the
required space exceeds the available
space, the scan button is unavailable.
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S  T  E  P    1

Operating Procedures

Click the arrow beside Scan Mode.

Select a scan mode from the pop-up menu.

Selecting the box opens
the pop-up menu.
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S  T  E  P    1

Verifying the Image before Scanning

Before initiating the final scan, it is advisable to check the intended results with the
Browser function. The image in the browser window is more accurate than the one in
the preview window, allowing you to verify the results more precisely before scanning.

To Verify the Image

Set the magnification and scan mode to the appropriate settings.

Click on the [Browser] button.
• The selection frame will appear in the preview window to enable a portion of the

image to be selected.
• The size and shape of the selection frame cannot be changed because it is

automatically determined by the scanning resolution.

Move the pointer in the selection frame inside the preview window.
• The mouse cursor will change to a “+” sign shape.

Move the Selection Frame to the desired position with the mouse cursor.
• Moving the mouse will move the Selection Frame.

Click the mouse button when the selection frame is in the correct
position.
• The image will be scanned and the browser image displayed in the middle of the

monitor.

Once you have examined the browser image, click the mouse button
again to close the browser window.
• The browser window will close.
• It does not matter where the mouse cursor is positioned to close the browser window.

➟

Selection Frame
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S  T  E  P    1

Rotating the Image

You can rotate the image in the preview window clockwise to the right
or counterclockwise to the left in increments of 90 or 180 degrees. To
rotate the image, click the appropriate button.

Caution
• If you rotate the image in the preview area, the scanned image will also

rotate.

Operating Procedures

Use these buttons to rotate the image:

To rotate the image counterclockwise 90 degrees

To rotate the image clockwise 180 degrees

To rotate the image clockwise 90 degrees
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S  T  E  P    1

Setting Preferences

The Preference settings determine how Plug-in Module CS-
U operates for the following options: output device
(printer, files), scan area setting method, size display units,
preview window size. You can change these options at any
time or restore the factory default settings. To change any
of these options, use the Preferences menu.

Output Device
Adds new output devices or file formats to the pop-up menu in the control panel.
Devices are displayed by name. Resolution and other settings can be changed for
the devices or the devices can be removed.

Hint
• The preset devices cannot be edited or deleted.

Aspect Ratio
To set the size of the area to be scanned, drag the mouse to size the selection
frame in the preview window. The area inside the borders of the selection frame
will be scanned.

Adds a new device.

Allows you to remove a device from the list.

Allows you to change
the name and
resolution setting.

When the [Constrained] setting is selected, choose a
paper size in the [Mode] option. The selection frame will
have a fixed aspect ratio (height to width ratio) when it is
resized in the preview window.

When the [Independent] setting is selected, the selection
frame can be freely resized and reshaped by dragging it.
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S  T  E  P    1

Unit
Specifies the units that define the size of the scanned image.

Preview Window
You can size the preview window and set its resolution. Enter a large value for a
large preview window size. You can also use this feature to set the auto preview
and preview cache options.

The units displayed in this section of the control panel will change.

Unit Settings Dialog

Click the appropriate radio
button for the function you
want to switch on
(Automatically perform a
preview, Save preview
image and None). Only one
button can be selected.

The maximum values are
determined by the type of
monitor you are using.

Allows you to enter values
and change settings for the
preview window options.

Preview Window Settings Dialog

Caution
• Changing the preview window size will cause the image previously

displayed in the preview window to disappear.

Hint
• If the “Save preview image” option is selected, the last preview image will

appear in the preview window when Plug-in Module CS-U is launched
again after quitting once. This reduces the steps required to rescan the
same image repeatedly.

During previewing, if you are running other tasks simultaneously
which may burden the computer extremely (i.e.: playing animation
and starting and editing a file with a size of more than 100MB),
uncheck this check box to set this setting off. The initial setting is
“Checked (On)”.
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S  T  E  P    1

Calibration
Adjusts the white balance to the correct value so that all the colors are scanned
correctly. Calibration takes approximately 1 minute. If the color balance of a
scanned image is off-balance, select this option to calibrate the scanner input.

Reset Default Settings
Returns the preference settings and all other settings to the factory default
settings. The tables list the major default settings.

Scan Mode Color
Magnification 100%
Unit Pixels
Basic Resolution 72 dpi
Control Panel Position Center
Image Recommended
Unsharp Mask Off
Descreen Off
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S  T  E  P    1

Operating Procedures

Open the [Preferences] menu in the control panel.

Select the desired option from the pull-down menu.
• Selecting any one of the Output Device, Aspect Ratio, Unit or Preview Window

options displays the respective dialog. Choose the desired value in the dialog and
select [OK] to change the setting.

• A confirmation dialog will display if Reset Default Settings is selected. The
settings will be reset if [OK] is selected in that dialog.
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S T E P  2

Scanning

Step 2 presents the procedures for conducting the final scan,

saving the scanned image in a file and editing image files.

Follow the procedures below to perform the final scan.

■    Setting the Scan Area   p. 30

■    Zooming   p. 31

▼
■    Scanning   p. 33

▼
■    Saving Scanned Images   p. 34
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S  T  E  P    2

Setting the Scan Area

Using the image in the preview window, you can define the actual area to be scanned.

Operating Procedures

Position the pointer in the preview window.
The [+] symbol marks the current position of the pointer.

Click and drag the mouse in the direction you want to define on the
image as a frame.
The selected area is enclosed in a dotted frame.  The area enclosed in this dotted
frame is the area that will actually be scanned.

• You may drag the frame in any direction.
• Clicking the mouse button outside the selection frame causes the selected area

to be deselected.
• Moving the mouse cursor within the selection frame changes it to an

omni-directional arrow [ ]. Dragging the cursor in this state will cause the
selection frame to move without changing its shape.

• Placing the mouse cursor over the dotted line of the selection frame causes the
cursor to change into one of four shapes [ ] [ ] [ ] [ ]. Dragging the
selection frame with the mouse cursor changes its shape.

• Double-clicking the mouse button anywhere in the preview window selects the
entire image.

Hint
• To specify small areas with precision, it is convenient to expand the

preview display with the Zoom In button. See Zooming (P. 31).

Selection Frame
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S  T  E  P    2

Zooming

You can specify a selected area of the image for enlargement with the zoom
features. You can use the zoom function to select an area with high precision,
or to select small areas for scanning.

Procedures to Zoom In

Select the area you want to enlarge with the zoom function.
See Setting the Scan Area (p. 30).

Selection Frame
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S  T  E  P    2

Click on the Zoom In button.
The selected area will be displayed in expanded form.
If you want to enlarge the image again, reduce the size of the area selected with
the frame and click the Zoom In button again.

Click the Zoom Out button to restore the view prior to zooming.

Hint
• The image cannot be zoomed unless an area is selected.
• The selection can be zoomed up to six times consecutively. If the selected

area is too small, the Zoom In button will be disabled and the selection
cannot be zoomed.

➟
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S  T  E  P    2

Scanning

Once you have set the magnification and scan mode, you may proceed with the
scan. Once the scan is complete, Plug-in Module CS-U automatically closes and
returns to the application software, such as CanoScan Toolbox or ArcSoft
PhotoStudio 2000. The following provides an example of scanning from within
ArcSoft PhotoStudio 2000.

To Initiate the Scan

Specify the Scan Area.
See Setting the Scan Area (p. 30).

Click on the [Scan] button.

• The scan will start.
• Plug-in Module CS-U will automatically quit when the scan finishes.

Hint
• The scan button cannot be clicked if the scan area is set too small (less

than 64x64 pixels) or not specified.
• The scan cannot be performed if the required memory is larger than the

free disk space.

➟
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Saving Scanned Images

Follow this procedure to save a scanned image with the parent software
application. The example below shows how to save a scanned image with ArcSoft
PhotoStudio 2000. See the ArcSoft PhotoStudio 2000 User’s Guide.

Operating Procedures
After an image is scanned, the image is displayed as “Untitled.” When you save
the image you can give the file a name and select the folder where it is to be
stored.

Open the [File] menu and select [Save As...]. The Save dialog will open.

Select the folder you want to use for the file.

Enter a name for the file and click the [Save] button.

Enter a file name here.

To select a folder, click the arrow and select
the name of the folder in which you want
to save the file.
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Adjusting Scanned Images

Scanned images may be corrected for brightness and color tone

or edited in a variety of ways.

The potential adjustments vary with the scan mode utilized in the preview.

Adjustments to the scanned image may be made after the image is previewed.

Grayscale, Color:
■  Tone Adjustment   p. 36

■  Histogram Settings   p. 37

■  Tone Curve Settings   p. 40

■  Brightness and Contrast Settings   p. 43

■  Adjusting the Color Balance   p. 45

■  Gamma Value Settings   p. 46

Black & White:
■  Adjusting the Threshold Value   p. 48

Color:
■  Auto Tone Correction   p. 49

■  Unsharp Mask   p. 50

■  Descreen   p. 51

■  Saving/Recalling Settings   p. 52

■  Scanning Techniques   p. 54
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Tone Adjustment

Use Tone Adjustment to enhance the brightness or color of the image in the preview area.
Open the [Image] menu and select [Tone Adjustment], or click the [Tone Adjustment] button,
to open the Tone Adjustment dialog so you can enhance the preview image.
You can also click the [Auto Tone Adjustment] button so the histogram highlights and
shadows are adjusted for you automatically to the optimum settings.

Caution
• Adjustments cannot be made when the ColorSync option is selected (p. 49).

Tone Adjustment Dialog
The Tone Adjustment dialog contains tabs for the following features: histogram, tone curve,
brightness/contrast, color balance, and gamma. If black and white has been selected as the
scan mode, the threshold feature also becomes available on the histogram tab.
The settings selected in the Tone Adjustment dialog are also reflected in the next preview
image. To scan a new item, ensure that you click the [All Reset] button to restore all of the
settings to their default values.

Auto Tone
Adjustment
Button

Tone Adjustment
Button

Image Menu

Displays the RGB
values at the
current cursor
position.
Pre-adjusted value/
post-adjusted value

Click the
appropriate
tab.

Here is the Tone Adjustment dialog with all
the tabs you will see when color or grayscale
has been selected as the scan mode.

Here is the Tone Adjustment dialog you will
see when black and white is selected as the
scan mode. Only one tab is available.
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Histogram Settings

The data comprising an image contains a variety of brightness settings ranging
from shadows to highlights. These settings are represented in Plug-in Module CS-U
by values ranging between 0 and 255. The difference in these values determines
the image’s contrast. To show how much of the image data falls into each
brightness setting, Plug-in Module CS-U contains a histogram feature that shows
this data distribution clearly. With the histogram you can adjust the level of
shadows and highlights to achieve beautiful tones with the best possible contrast.

Hint
• You can enhance images with the histogram options only when the image

has been previewed in the color or grayscale scan modes.
• You cannot enhance the image with the histogram when ColorSyncTM is

selected.

How to Interpret Histograms
You can select the entire image or specify an area for which a histogram will be
generated. The height of the peaks of the histogram is directly related to the
volume of data with the corresponding value.

Portion with
Highlights

Portion with
Shadows

Entire Image

Distribution of data
with a bias toward
highlights.

Distribution of data
with a bias toward
shadows.

Distribution of data
widely distributed
between shadows and
highlights.
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How to Adjust Histograms
To change the contrast in an image, the distribution of data between shadows and
highlights can be adjusted by dragging the shadow and highlight marks at the bottom
of the histogram. All of the data lying to the outside (left) of the shadow mark is
changed to a zero value and all of the data lying to the outside (right) of the highlight
mark is changed to a 255 value. The examples below show adjustments to improve the
contrast. Use the [Auto] setting to adjust the histogram for most jobs (p. 41). The
graphs below show images adjusted with the Auto setting.

To Adjust a Histogram

Specify the area of the image (the entire area to be scanned) for which a
histogram will be generated. See Setting the Scan Area (p. 30).
The histogram will not display correctly if an extremely small area is selected. To select
small areas, first expand the display with the Zoom In button. See Zooming (p. 31).

Click the histogram tab in the Tone Adjustment dialog to display the
histogram options.

Click the [Auto] button.
Although you can freely move the shadow mark and highlight mark to another
position, the image can be adjusted easily for optimum effect with the Auto
button.

Move the highlight mark
toward the shadow end.

Move the shadow mark
toward the highlight end.

Move both the shadow and
highlight marks inward.

Image with a bias
toward highlights

Image with a bias
toward shadow

Image with well
distributed data

IMAGE
1

IMAGE
2

IMAGE
3
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Click on the [OK] button.
The preview image will change according to the values specified with the
histogram.

Hint
• The histogram dialog can also be displayed by selecting [Tone Adjustment]

from the [Image] menu.

Highlight Mark
All of the data to the
right of this mark is set
to the highlight (255)
value. Drag the mark
to the right or left.

Clicking directly on this bar causes the shadow or highlight
mark, whichever is closest, to advance to that position.

Shadow Mark
All of the data to the
left of this mark is set
to the shadow (0)
value. Drag the mark
to the right or left.

The Tone Adjustment
settings can be saved
in a file and reloaded
for later use.

Black Eyedropper Button
Click the Black Eyedropper
and click the position in the
preview image you want to
set to black (0).

To restore the histogram
settings, click this
[Reset] button.

To restore all settings
to their defaults, click
the [All Reset] button.

White Eyedropper Button
Click the White Eyedropper
and click the position in the
preview image you want to
set to white (255).

Displays the current
level at the highlight
mark. Click the up or
down arrows in the
spinbox to increase or
decrease the setting or
enter a number directly
into the entry box
(1~255).

Auto Button
Automatically sets
the highlight and
shadow settings for
optimum effects.

Displays the current
level at the shadow
mark. Click the up or
down arrows in the
spinbox to increase or
decrease the setting or
enter a number directly
into the entry box
(0~254).

The histogram settings can be adjusted for all channels (Master) or for individual
channels (R, G, B).  The selectors are displayed to the left of the histogram graph
(Master, R, G, B). The Master selection is unavailable if Grayscale has been
selected as the scan mode.
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Tone Curve Settings

You can edit the tone curve directly by changing the shape of the line on the
graph.  When you change the setting by manipulating the curve, you can perform
fine adjustments in the brightness of only the shadows, only the highlights, or both
the shadows and highlights.

Hint
• You cannot use this feature with the black and white or color scan modes

when ColorSync is selected.

Manipulating the Graph
The following examples show you how to manipulate the graph to change the
settings. When you test these settings yourself, you can see the changes
immediately reflected in the preview window or the browser to achieve many
interesting effects.

OUTPUT

INPUT

OUTPUT

INPUT

OUTPUT

INPUT

Unadjusted Curve

If you want to
brighten the
light areas ...

If you want to
invert the
shadows and
highlights ...

Drag the mid-tones of the input side
(scanned image) into the highlights of the
output side (displayed image)

Reverse the starting and end points of the
line to invert shadows and highlights.

(If the image is in color, the colors are
switched to their complementary colors.)
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To Edit the Tone Curve

In the Tone Adjustment dialog box, click the tone curve tab.

Change the tone curve in any direction to adjust its shape.

Click the OK button.
The image in the preview window changes to reflect the new settings.

You can adjust the setting for each
channel: R (red), G (green), B (blue)
or M (master). You can adjust each
channels independently. (You can
adjust RGB only for a color image.)

Shows the input and
output level at the
point under the pointer
(control point) in the
graph, expressed as a
value from 0 to 255
where 0 is the darkest
and 255 the lightest.
If the output level is
larger than the input
level, this results in a
lighter image.

To create a control point on the line, just click anywhere
in the graph. After a control point is displayed in the line
you can click to move it in any direction. As you move it
to another location, the value changes. You can set
several control points on the tone curve.

To restore the tone
curve default settings,
click this button.

To restore all the
default settings, click
this button.

The Tone Adjustment settings can be saved in a file
and reloaded for later use.
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The Relationship Between the Tone Curve
and Image Brightness

Tone curve values fall with a range of 0.01 to 10.00.  A value of 1 appears as a
straight line in the graph, and if the value is any value other than one, the line on
the graph will appear curved. The relationship between the shape of the curve and
image brightness is explained below.

Value = 1
Input and output and are equal
and the curve appears as a
straight line, and the input
image is displayed on the
screen without adjustment.

Value > 1
The data bends upward over
the range of input values from
shadows to highlights, making
the adjusted image brighter in
the display.

Value < 1
The data bends downward over
the range of input values from
shadows to highlights, making
the adjusted image darker in
the display.

CAUTION
• The tone curve cannot be adjusted manually in one of the color scan

modes when ColorSync is selected because the color balance is adjusted
automatically.

• The tone curve cannot be adjusted for a black and white image because
mid-tones are shown as either black or white. To adjust the brightness of
a black and white image, use the threshold setting (p. 48).
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Brightness and Contrast Settings

You can adjust the image with two slide bars, one for contrast and one for
brightness. Use this method to adjust an image before scanning if it is slightly out
of focus or too dark.

Hint
• You cannot use this feature with the black and white or color scan modes

when ColorSync is selected.

Contrast
Contrast is the difference between the lightest light and the darkest dark in the
image. A high contrast setting creates a great difference between light and dark
shades, and there is a very sharp distinction between light and dark areas of the
image. A low contrast setting creates a small difference between light and dark
shades, and the distinction between light and dark areas of the image are not as
obvious.

If the image appears slightly out of focus, increase the contrast setting to sharpen
the image. If the contrast setting is too high, shadows will blacken and the
highlights will wash out.

Brightness
Brightness is the overall lightness or darkness of an image without changing the
contrast. Adjust the brightness setting to change the overall lightness or darkness
of the entire image. If the brightness setting is too high, the highlights will wash
out, and if too low, the shadows will blacken.

Contrast = 128 (Normal) Contrast = 100Contrast = 170

Brightness = 128 (Normal) Brightness = 80Brightness = 190
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To Adjust the Brightness and Contrast

In the Tone Adjustment dialog click the brightness/contrast tab.

Adjust the brightness/contrast settings by dragging the slidebars,
changing the value with the spinbox buttons, or entering the value
directly into the entry box.

Click the [OK] button.
The settings will be reflected in the image currently displayed in the preview
window.

Drag the slidebar left or right to adjust the
brightness setting.

You can also click the up or down arrow in the
spinbox to raise or lower its value or enter a
number directly into the entry box (-127~+127).

Drag the slidebar left or right to adjust the
Contrast setting.

The Tone Adjustment settings can be saved in a
file and reloaded for later use.

To restore all the default settings, click this button.

To restore the brightness/contrast default settings, click this button.
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Adjusting the Color Balance

You can enhance color matching by adjusting the color balance of one or all of the
three primary colors: red, green and blue (RGB). Use this feature to adjust the color
balance when you see an over-abundance of a color in a scanned image.

Hint
• You cannot use this feature with the black and white or grayscale scan

modes, or with the color scan modes when ColorSync is selected.
• There may be wide differences in the contrast and hue of the display

image and printout, depending on the monitor and printer settings. You
may have to adjust the settings and execute some test prints to attain the
best match between what you see in the image on the display and in the
printout.

Operating Procedure

Click the color balance tab in the Tone Adjustment dialog.

Adjust the color balance for each or all of the primary colors: red, green
and blue (RGB).

Click the [OK] button.

Adjust the color by dragging the slidebar
left or right.

Click the up or down arrow in the spinbox
to increase or decrease the number value
or enter a number directly into the entry
box (-127~+127).

To restore the color balance default settings, click this button.

The Tone Adjustment settings can be
saved in a file and reloaded for later use.

To restore all the default settings, click this button.
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Gamma Value Settings

By adjusting the gamma value, you can more closely match brightness of the
displayed image to the printed image. Adjust this value if what you see on the
screen is very different from your printout.

Hint
• You cannot use this feature with the black and white scan mode, or with

the color scan modes when ColorSync is selected.

Matching the Gamma Value to the Display Characteristics
Not all screen displays reproduce color tones in exactly the same way, and this
reproduction method is expressed as a gamma value from 1.4 to 2.2 and normally
reproduces a slightly dark image.
In order to avoid this and reproduce an image that is faithful to the original, the
gamma value must be adjusted in Plug-in Module CS-U. Plug-in Module CS-U can
adjust the pre-set screen gamma value of 1.8, but if the screen has a gamma value
other than 1.8 then the gamma value for that screen must be set.

Gamma value
Plug-in Module CS-U and the screen display have different gamma values. During a
scanning job Plug-in Module CS-U receives the image read from the scanner as
input and sends it to the parent application as output. The gamma value in this
interval where Plug-in Module CS-U converts input to output is the Plug-in Module
CS-U gamma value.
On the other hand, the data received from Plug-in Module CS-U as input is sent to
the screen display as output. The gamma value in this interval where the image
input from Plug-in Module CS-U is converted to output for the screen display is the
screen display gamma value.
Setting the screen display gamma value causes the scanner gamma value to be
calibrated automatically as the inverse value. For example, if the screen display
gamma value is set for 1.8, then the scanner gamma value is calibrated for 0.56
(the inverse of 1.8).

Hint
• Please read the documents shipped with your display or contact the

manufacturer’s customer service department to obtain the correct gamma
value for your particular display model.

• If you intend to adjust the color tone with ColorSync™, change the
settings in the ColorSync™ control panel (found within the Control Panels
folder) and do not manually change the gamma value settings as
described in the following pages.
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To Change the Gamma Value Settings

Click the gamma tab in the Tone Adjustment dialog.

Click a pre-set value or the custom option.

Click the [OK] button.
The changes are reflected in the image currently displayed in the preview window.

Click the appropriate radio button to select a
numerical setting.

Drag left or right to
change the setting.

Click the up or down
arrow in the spinbox to
increase or decrease the
value or enter a number
directly into the entry box
(0.1~10.0).

The Tone Adjustment settings can be
saved in a file and reloaded for later use.

To restore the gamma default settings, click this button.

To restore all the default settings, click this button.

After you click the [Custom] button, you can
drag the slidebar to adjust the setting, or you
can enter a value directly into the entry box.
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Adjusting the Threshold Value

When the scan mode is set to black and white, the image brightness can be
adjusted. The threshold value setting determines whether a halftone will be
expressed as a black or a white data point. The possible threshold values range
between 0 and 255. Below a given threshold value, all data is converted to black.
Likewise, all data with a value above the threshold is converted to white.
Accordingly, higher threshold values produce darker images while lower threshold
values result in brighter images.

To Set the Threshold Value

When the scan mode is set to black and white, click the [Tone
Adjustment] button or pull down the Image menu and select [Tone
Adjustment].

Threshold Value = 128 (Standard) Threshold Value = 70Threshold Value = 180

Click the [OK] button.
The preview image will change to reflect the new settings.

Drag the slidebar left or right to adjust the
threshold setting.

After adjusting the threshold value, you can
save the setting to a file under a file name and
load the file again whenever you want to use
the setting.

Click the up or down arrow to increase or
decrease the entry in the text box, or enter the
value (0~255) directly from the keyboard.

To restore the threshold setting to its default value, click this button.
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Auto Tone Correction

When the selected scan mode is Color, you have three options for adjusting the color:
Recommended, ColorSync or None. The default setting is [Recommended].

Recommended
Use this option if scanned images are to be viewed primarily on the computer display
with photo album software. This method adjusts the computer display to reproduce
the color balance of the original as closely as possible.

ColorSync
Use this option if the scanned images are to be output to a printer. This method
automatically harmonizes the color adjustment functions of scanners, displays and
printers for consistent color matching. The printer must also have its ColorSync
setting set to On.

Caution
• This function is available only when the scan mode is set to one of the color

modes; not to the grayscale or black and white modes.
• The Tone Adjustment menu item, Tone Adjustment button and Auto Tone

Adjustment button are disabled when the ColorSync option is selected.
• The previous settings are in effect when Plug-in Module CS-U is started from an

application program that does not display the Plug-in Module CS-U control panel.

Hint
• ColorSync™ responds differently to each computer according to the unique

conditions affecting it (type of display used, etc.), which may cause
differences even between computers of the same make and system version.
The tone characteristics of an image scanned with ColorSync™ on one
computer, therefore, may change when processed on another computer.

To Set the Auto Tone Correction

Open the [Image] menu and select [Recommended], [ColorSync] or
[None].

A check mark will appear beside the selected option, which will take effect.



50

S  T  E  P    3

Unsharp Mask

The Unsharp Mask function enhances the outlines of an image. When set to On,
this function makes the image outlines appear sharper without changing the
brightness, contrast or color balance, giving it a natural look. It is particularly useful
for scanning images that are slightly out of focus.
The function is on when a check mark appears beside it and off when there is
none. The default value is Off.

Caution
• This setting is not available for the black and white scanning mode.
• If Plug-in Module CS-U is started within an application that hides the

Plug-in Module CS-U control panel, the previous setting will be
maintained.

Operating Procedures

Open the [Image] menu and select [Unsharp Mask].

A check mark will appear beside the Unsharp Mask option in the menu when this
function is set to On. To set it to Off, reselect it. The check mark will disappear.

Hint
• Disable the Unsharp Mask function if the moiré effect is still too strong

even when the Descreen option is on.
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Descreen

Moiré patterns occasionally appear when items printed at high resolutions are
scanned. To reduce this phenomenon, scan photographs and other high-resolution
prints with the Descreen function enabled. Shut it off to scan lower resolution
items, such as newspapers, books and magazine text. The default setting is “off.”

Caution
• The Descreen function cannot be switched on for scanning resolutions

higher than 601 dpi.
• The previous setting is enabled for the Descreen function when Plug-in

Module CS-U is opened by a software application operating in the
windowless mode.

Operating Procedures

Open the [Image] menu and select [Descreen].

A check mark will appear beside the Descreen option in the menu when this function is
set to On. To set it to Off, reselect it. The check mark will disappear.
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Saving/Recalling Settings

The scan mode, resolution and preference settings can be saved with a preview
image to a settings file and recalled for future processing. The user may freely
assign a name to the settings file. It is convenient to save frequently used settings
in a file.

Hint
• In addition to settings, the settings file may also be used to store preview

images. It is useful to save the preview image with the settings to quickly
grasp to which image the settings apply.

To Save Settings in a Settings File

Open the [Setting File] menu and select [Save].

Specify the folder where you want to store the file and enter a name for it.

Click the [Save] button.

Insert a check mark by clicking this box to have a copy
of the preview image saved with the settings file.
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To Recall a Settings File

Open the [Setting File] menu and select [Load].

Select the folder where the file is stored and click the name of the file
you want to load.

Click the [Open] button.
The file you selected opens and the settings stored in the file are enabled for the
Tone Adjustment settings.
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Scanning Techniques

Matching Scan Resolution to Purpose
Plug-in Module CS-U provides many choices of resolution. The resolution you
choose should depend upon your output device, the intended purpose of the
image, the type of image and your scanner.

It is generally recommended that you scan at a higher resolution than required for
output. This ensures that you obtain the best quality image, which can then be
reduced with an image editing program to suit specific purposes.

Different types of images require different scan settings. However, increases in scan
resolution have a diminishing return after a certain point. For example, a text
image can be scanned at 600 dpi for output to a 600 dpi laser printer, while a color
image should be scanned at 180 dpi to be output to a color bubble jet printer (360
dpi). To output a color or grayscale image to a bubble jet printer, use a resolution
equal to half the resolution of the printer. Set the resolution to 180 dpi, for
example, for output on a 360 dpi printer.

• Scan in black and white mode if you are scanning line art or other items that are
black and white with no shades of gray.

• Scan in black and white mode if you are scanning a text image for conversion to
editable text.

• Scan in grayscale mode if you are scanning continuous-tone black and white
photographs, charcoal drawings or originals with shades of gray.

• Scan in Color mode if you are scanning full-color images, such as photographs or
illustrations.

• If you are using an OCR (optical character reader) program in black and white
mode, you are recommended to select a resolution higher than 300 dpi.

• The minimum scannable height and width will vary with the scanning resolution.
At 75 dpi, for example, the minimum selectable height and width in the preview
area is 9 pixels (approximately 0.12 inches or 0.30 cm). At 300 dpi, it is 35 pixels
(approximately 0.12 inches or 0.30 cm).

Optical Resolution
Optical resolution refers to the amount of information a scanner can sample per
inch. Different varieties of scanner feature different optical resolutions. The
maximum optical resolution of the CanoScan D646U models is 600 dpi for the
primary scan (horizontal dimension of the document), and 1200 dpi for the
secondary scan (vertical dimension).
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Troubleshooting

Please refer to the following information if you encounter a problem using Plug-in
Module CS-U. For further details, refer to the Troubleshooting item on the CD-
ROM provided with your scanner.

If your problem lies outside the solutions provided below, consult the retail outlet
from which you purchased the software or the closest Canon Customer Support
Help Desk.

Hint
• Before you call for assistance, read the Getting Started guide.
• When you contact one of the help desks listed, you will be asked what

kind of computer is connected with the scanner.  Before you call, make
sure you have prepared the information required on the system
information page in the Quick Start Guide.

Problem: The “Can’t use the driver required for a USB device. Search the
Internet for a driver?” dialog displays on a system running
Mac OS 9 (only applicable to Mac OS 9)

➤ Solution: Scanner software has not been installed. Click the [Cancel] button to
close the dialog. Detach the scanner, and install the required
software from the CanoScan Setup Utility CD-ROM before
reattaching the scanner. (➜  Quick Start Guide)

Problem: Plug-in Module CS-U does not appear as an option on the
menus of a plug-in compatible application program

➤ Solution: Plug-in Module CS-U is not correctly installed on your hard disk
drive. Reinstall Plug-in Module CS-U. (➜  Quick Start Guide)

Problem: The image will not appear even if the Preview button is
clicked on the Plug-in Module CS-U control panel

➤ Solution 1: Make sure the original is set on the document glass correctly

➤ Solution 2: The brightness settings for Plug-in Module CS-U may be set too
high. Try lowering the brightness settings. For details about
brightness setting, see Brightness and Contrast Settings (➜  p. 43)

➤ Solution 3: The threshold setting for Plug-in Module CS-U may be set too high.
Try lowering the threshold setting. For details about setting the
threshold setting, see Adjusting Threshold Value (➜  p. 48)
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Problem: Scan button cannot be selected

➤ Solution 1: A scan cannot be performed if the scan area is set too small (less
than 64 x 64 pixels). Increase the size of the scan area

➤ Solution 2: A scan cannot be performed unless a scan area is specified. Specify a
scan area

➤ Solution 3: A scan cannot be performed if the required memory is larger than
the free memory. Change the resolution (➜  p. 19) or scan area
(➜  p. 30) until the required memory is lower

Problem: The “Insufficient Memory” error message appears when
scanning

➤ Solution 1: Select the smallest possible area and rescan

➤ Solution 2: Lower the resolution and magnification settings for the output
device to the lowest possible values (➜  p. 19)

➤ Solution 3: Rescan after closing all the application programs other than the one
used to start Plug-in Module CS-U

➤ Solution 4: Rescan after you have restarted the application program used to
start Plug-in Module CS-U

➤ Solution 5: Quit the application program used to start Plug-in Module CS-U and
increase the memory allocated to it. Click the application program
icon once. Then open the [File] menu, choose [Get Info], and choose
[Memory] from the submenu. Increase the memory in the Preferred
Size box to at least 12000 K.

➤ Solution 6: Increase the amount of RAM as required

Problem: The [Image] menu [ColorSync] option cannot be used in
Plug-in Module CS-U

➤ Solution: ColorSync is not recognized after Mac OS upgraded to Version 9
after Plug-in Module CS-U was installed onto Mac OS 8.6. Reinstall
Plug-in Module CS-U (➜  p. 6)
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Problem: No free disk space message displays when you start a scan

➤ Solution: Since there is insufficient free space on your hard drive, clear non-
essential files to create more space.

Problem: Scanning is taking a long time

➤ Solution: Resolution is set too high. Lower the resolution to the minimum
required settings and rescan.

Problem: Colors in the Preview area are strange

➤ Solution 1: The original is faded. Try retouching the colors with an image editing
program. (image editing program manual)

➤ Solution 2: Color balance and brightness are incorrectly set.  Reset them.

Problem: Entire image is whited out (or blackened) when the image
type is set to black and white

➤ Solution: The threshold value is set too low (or high). Increase (decrease) the
threshold value.

Problem: Scanning quality is poor

➤ Solution 1: Resolution is too low. Raise it and rescan.

➤ Solution 2: Original is floating off the document glass (platen). Place the original
correctly on the document glass.

➤ Solution 3: Document glass or underside of the document cover is dirty. Clean
them.

Problem: Smudges are appearing on glossy color photo scans

➤ Solution: Photos are adhering to the document glass are causing the light to
refract, creating the striped patterns. Shift the photo to a different
position on the document glass or clean the document glass before
rescanning.
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Problem: Coloring of the preview image and the printed image is
different

➤ Solution 1: Insufficient printer toner (ink). Replenish or replace the toner. (printer
manual)

➤ Solution 2: Color balance or gamma value setting in the printer driver doesn’t
match the printer. Manually adjust the settings in the printer driver.
(printer manual)
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Error Messages

Response

• Use the USB cable to connect
the Macintosh to the scanner
properly and connect the AC
adapter correctly to the
scanner.

• After releasing the lock,
temporarily disconnect the AC
adapter or USB cable.
Reconnect it and restart Plug-
in Module CS-U.

• Contact your nearest Canon
Customer Support Help
Desk.

• Reduce the scan area to the
minimum possible scope and
lower the resolution and
magnification settings for the
output device.

• Close all application programs
other than the one used to
start Plug-in Module CS-U.

• Increase the memory allocated
to the application program
used to start Plug-in Module
CS-U. (➜  p. 57)

• Click [Cancel] to cancel, or
rescan after lowering the
scanning resolution or
reducing the scanning area.

• Restart the computer.
If the same error code displays
after restarting the computer,
contact the nearest Canon
Customer Support Help
Desk.

Error Message

Scanner is not connected.
Connect the scanner.

Scanning unit is locked.
Release the lock switch at
the base of the scanner
and connect the PC to
the scanner again.

1) Cannot complete scan
command. Insufficient
memory (RAM).
2) Memory is insufficient.
Increase the memory
allocated the application.

As image size is large,
it will take long to
complete scanning. Do
you want to continue?

An error has occurred.
Error Code =** Restart
the PC.

Cause

• AC adapter and USB
cable not connected
correctly.

• The scanning unit
lock not released.

• The scanning unit is
out of order.

• Memory is
insufficient for the
required volume of
the scanned image
data.

• You attempted to
scan an image
exceeding 100 MB.

• Scanner or computer
is malfunctioning.
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Glossary

Auto Tone Correction
A function that uses brightness/contrast and gamma value settings to
automatically analyze and adjust images.

Bits/Bit Numbers
Each dot of a 1-bit image is assigned either black or white according to the
threshold brightness value, resulting in the image being reproduced in just
those two colors. Each dot of an 8-bit grayscale image can be assigned any one
of 256 tones of gray, ranging from pure white to black. Each dot of a 24-bit
color image can be assigned any one of 16.7 million colors since each of its
color channels (red, green and blue) can be expressed in 256 distinct color tones
(8 bits).

Black and White
An image mode used to reproduce images in two tones only: black and white.
The brightness level at which a dot is determined to be either black or white is
called the threshold value, which can be adjusted. See Threshold Value.

Black Eyedropper Tool
Tool used to the select the darkest portion of an image in the preview area.
Used with the Histogram function to adjust image brightness. When this tool is
clicked on the image, all areas that are darker are set to pure black.

Brightness
The intensity of light in a scanned image. Raising an image’s brightness
increases its overall brilliance, while decreasing it makes it darker.

Calibration
A scanner function that automatically adjusts the scanner’s color balance to
true.

Color Balance
The function in that enables you to adjust the blend of colors in a color image.
You can adjust the color balance by altering the blend of the red, green and
blue color set or the cyan, magenta, yellow and black color set.
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Color Channel
Any one of the red, green or blue elements of a color image. Since color images
are assigned 8 bits per pixel for each of the red, green and blue channels, each
pixel is assigned 24 bits of data. The master channel is the composite of these
three channels. In the Histogram and Tone Curve image adjustment functions,
each channel can be separately or collectively adjusted.

Color
An image mode that scans an image as red, green and blue (RGB) light and can
reproduce each one of these three colors in 256 distinct tones (8 bits). Since
256 x 256 x 256 = approximately 16.7 million, this many color tones are
possible in this mode.

ColorSync
A color management system for Macintosh computers. Automatically
compensates for color differences between scanners, monitors and printers.
ColorSync requires that a color profile file be included for your specific monitor
or printer.

Contrast
The difference between light and dark areas of a scanned image. Raising the
contrast makes individual components of an image stand out more while
lowering it softens the image’s overall appearance.

Dot
The basic element used to reproduce images. Images are reproduced as
columns and rows of dots. A scanner’s resolution is the measure of the number
of dots it can read and reproduce per inch (dpi).

DPI
Dots per inch. An expression of monitor and printer resolution. Measured as the
number of dots per horizontal inch on monitors and the number of dots that
can be printed by a printer in an inch. See also Pixel, Optical Resolution and
Resolution.
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Gamma Value
A function for adjusting the overall brightness of an image. A gamma value is
the mathematical expression of how brightness data is converted from a
scanner (the input) to a monitor or printer (the output). With 1 as the base
value, a gamma value less than 1 makes an image darker, while a higher value
makes it brighter. The brightness handling characteristics of monitors vary
between manufacturers and models. A monitor’s gamma value explains the
degree to which its output (what you see on the screen) varies from the input
value.

Grayscale
An image mode that scans only the brightness data of an image and reproduces
the image in white, black and 254 shades of gray (256 tones or 8 bits).

Histogram
A graph indicating the distribution of brightness data in an image. A dot is
assigned a brightness value ranging from 0 (shadows) to 255 (highlights). The
histogram shows how much image data there is at each brightness value.
Adjusting the histogram changes the image contrast.

Image File
Images are expressed as collections of dots with varying color and brightness
values that are digitized in particular formats for processing by a computer. At
the most basic level, an image file contains bitmap information, which is the
color information for each dot in each column and row of an image. The
various file formats (TIFF, BMP, etc.) use different methods of storing and
recalling this information.

Magnification
An expression of the relationship between the scanning resolution and the
output resolution stated as a percentage. If the output resolution is set to 720
dpi and the scanning resolution to 360 dpi, then the magnification rate is 50%.
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Moiré
The patterns or lines created by overlapping dots in an image. This
phenomenon is found when photographs or pictures are scanned from books
and magazines at low resolutions. The Descreen function helps to eliminate
moiré patterns.

Optical Resolution
An expression of the volume of data per inch (dpi) that can be sampled by a
scanner.

Pixel
An abbreviation of picture element, the smallest element on a monitor screen.

Plug-in Software
A program that extends the functionality of an application program. Plug-in
Module CS-U is a driver plug-in that adds scanning capabilities to programs
such as CanoScan Toolbox and PhotoStudio 2000.

Preview Area
Area at the right of the Plug-in Module CS-U window used to display preview
images. Clicking the [Preview] button causes the scanner to scan its platen and
reproduce the image in the preview area. Please note, however, that preview
images do not get downloaded to the application program in use.

Preview Scan
A low-resolution, trial scan of an object. The image shown in the preview area
can be used to adjust the scan area, brightness and color balance before
initiating the final scan.

Resolution
The density of the dots used to express an image. Image fineness or coarseness
is expressed as the number of dots per inch (dpi). See also DPI.

RGB
A color set of red, green and blue: the three primary colors of light. The scanner
picks up light reflected off objects with its red, green and blue sensors. Color
printers output color using the complements to the RGB color set, which are
cyan, magenta, yellow and black (CMYK). Cyan, magenta and yellow are called
the three secondary colors.
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Scan Mode
Any one of the various methods used to reproduce image data. Scan modes are
distinguished by the number of bits used to describe each pixel. Plug-in Module
CS-U features the following scan modes.
• Color: assigns 8 bits of data for each color channel (RGB) in each pixel. Each

pixel is therefore assigned 24 bits.
• Grayscale: assigns 8 bits of data to its single color channel. Each pixel is

therefore assigned 8 bits.
• Black and White: assigns 1 bit of data to each pixel.

Scanning
The process of using a scanner to read image data. Scanned data is sent to the
computer as image data.

Shadows
The darkest portions of an image scanned in a color or grayscale image mode.

Threshold Value
The dividing value at which a pixel is determined to be either black or white
when the image is reproduced as a black and white image. The higher the
threshold, the darker the image. The lower the threshold, the brighter the
image.

Tone Curve
A function used to adjust image brightness. The tone curve (or gamma curve) is
a graphic representation of the relationship of the input from the scanner to the
output to the monitor or printer.

Unsharp Mask
A function that sharpens image outlines. Makes an image appear naturally
sharper without changing the brightness, contrast or color balance.

White Eyedropper Tool
Tool used to the select the brightest portion of an image in the preview area.
Used with the Histogram function to adjust image brightness. When this tool is
clicked on the image, all areas that are brighter are set to pure white.
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No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into
any language in any form by any means without the prior written permission of Canon Inc.

Canon Inc. makes no warranties for damages resulting from corrupted or lost data due to the operation or
malfunction of hardware and software.

While every effort has been made to ensure that the information contained in this guide is accurate and complete,
no liability can be accepted for any errors or omissions. Canon Inc. reserves the right to change the specifications
of the hardware and software described within this guide at any time without prior notice.

Please take note that international copyright laws prohibit the scanning of copyright-protected materials for any
uses other than for personal use.

CanoScan and Canon Plug-in Module are trademarks of Canon Inc.

Macintosh, Power Macintosh, Mac OS and ColorSync are trademarks of Apple Computer, Inc., registered in the
U.S. and other countries.
iMac is a trademark of Apple Computer, Inc.

Adobe® and Adobe® Photoshop are trademarks of Adobe Systems Incorporated.

Other names and products are trademarks or registered trademarks of their respective companies.
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Canon Customer Support Help Desk

CANON INC.
30-2, Shimomaruko 3-chome, Ohta-ku
Tokyo 146-8501, Japan

CANON U.S.A., INC.
Digital Home and Personal Systems
Division

2995 Redhill Avenue
Costa Mesa, CA 92626, U.S.A.
1-800 OK CANON

http://www.ccsi.canon.com

CANON CANADA INC.
6390 Dixie Road, Mississauga
Ontario L5T 1P7, Canada
1-800 OK CANON

http://www.canon.ca

CANON LATIN AMERICA, INC.
6505 Blue Lagoon Drive, Suite 325
Miami, Florida 33126, U.S.A.

CANON MEXICANA, S. de R.L. de C.V.
Anillo Periferico Sur No. 4124, Torre Zafiro (II)
Colonia
Ex-Rancho de Anzaldo, Piso 5 y 6, Mexico
D.F.

Tel. (525) 5490-2000

CANON PANAMA, S.A.
Apartado 7022, Panama 5
Rep. de Panama

Tel. (507) 279-8900

CANON CHILE, S.A.
Ave.  Manquehue Norte #1337, Piso 3,
Casilla 187-9,
Santiago, Chile

Tel. (562) 366-6600

CANON ARGENTINA, S.A.
Ave. Corrientes 420 (1043)
Buenos Aires, Argentina

Tel. (5411) 432-59800

CANON EUROPA N.V.
P.O. Box 2262 1180 EG Amstelveen,
The Netherlands

CANON (UK) LTD.
Woodhatch, Reigate
Surrey RH2 8BF, United Kingdom
For technical support, please contact Canon
Helpdesk.
Helpdesk:

P.O. Box 431, Wallington, Surrey SM6 0XU
TEL: (08705) 143 723
FAX: (08705) 143 340
For sales enquiries: (0121) 666-6262

CANON FRANCE S.A.
17, quai du Président Paul-Doumer
92414 Courbevoie Cedex, France

Tél.01 4199 7777  Fax.01 4199 7951
Hotline: Tél.01 4199 7070

CANON DEUTSCHLAND GmbH
Postfach 528, 47705 Krefeld, Germany
CANON- Hotline-Service

Customer Support: (0 21 51) 349-555
Info-Desk: (0 21 51) 349-566
Mailbox: (0 21 51) 349-577
Telefax: (0 21 51) 349-588

CANON ITALIA S.p.A
Palazzo L, Strada 6,
20089 Milanofiori-Rozzano (MI), Italy

TEL: 02/8248. 1  FAX: 02/8248. 4604
Pronto Canon 02/8249. 2000
http://www.canon.it

CANON BENELUX NEDERLAND N.V.
Neptunusstraat 1, 2132 JA Hoofddorp
The Netherlands

Tel: 023-5 670 123  Fax: 023-5 670 124
Helpdesk: 023-5 681 681

CANON BENELUX BELGIUM N.V./S.A.
Bessenveldstraat 7, 1831 Diegem, Belgium

Tel: 02 7220411  Fax: 02 7213274
Helpdesk: 02 7220404

CANON GmbH
Zetschegasse 11, 1232 Wien, Austria

CANON (SCHWEIZ) A.G.
Industriestrasse 12, CH-8305 Dietlikon
Switzerland

Tel: (01) 835 61 61  Fax: (01) 835 68 60
Hotline: 157 30 20

CANON ESPAÑA S.A.
C/Joaquin Costa No 41, 28002
Madrid, Spain

Help Desk: 906.301255
Tel.: 91-5384500  Fax.: 91-4117780

CANON DANMARK
Vasekær 12, DK-2730 Herlev, Denmark

Hotline: 44 88 26 66
http://www.canon.dk

CANON NORGE AS
Hallagerbakken 110, Boks 33, Holmlia, 1210
Oslo 12, Norway

Tlf: 2262 9321  FAX. 2262 0615

CANON SVENSKA AB
Gustav III:s Boulevard 26, S-169 88 Solna,
Sweden

Tel 08-744 85 00
Fax 08-744 64 65
http://www.canon.se

CANON OY AB
Kornetintie, 3, 00380 Helsinki, Finland

Puhelin: 010 544 20
Helpdesk: 0600-0-22606

(maksu 14,80 mk/min)
Fax: 010 544 4571

CANON SINGAPORE PTE. LTD.
79 Anson Road #09-01/06
Singapore 079906

http://www.canon-asia.com

CANON MARKETING SERVICES PTE.
LTD.

No. 1, Jalan Kilang Timor
#09-00 Pacific Tech Centre
Singapore 159303

Tel:  65-7998888, Fax:  65-2736786,
Hotline:  65-3342726

http://www.canon.com.sg

CANON MARKETING (MALAYSIA)
SDN. BHD.

Block D, Peremba Square
Saujana Resort, Section U2, 40150 Shah
Alam
Selangor Darul Ehsan, Malaysia

Tel:  603-7446000, Fax: 603-7446048,
Helpdesk:  603-7446008/9
Enquiry:  print&scan@canon.com.my
http://www.canon.com.my

CANON MARKETING (THAILAND) CO.
LTD.

179/34-45 Bangkok City Tower, 9th-10th
Floor
South Sathorn Road, Thungmahamek,
Sathorn, Bangkok 10120, Thailand

Tel:  662-3449999, Fax:  662-3449968
http://www.canon.co.th

CANON MARKETING (PHILIPPINES)
INC.
Marvin Plaza Building, 2153 Don Chino
Roces Ave,
Makati City, Metro Manila, Philippines
Tel:  632-8126047, Fax:  632-8120067/
8109797

CANON INDIA PVT LTD.
Neela Gagan, Mandi Road,
Mehrauli, New Delhi-110030, India
Tel:  91-11-6806572, Fax:  91-11-6807180

CANON HONGKONG CO., LTD.
9/F, The Hong Kong Club Building
3A Chater Road, Central, Hong Kong

TEL:  (852) 2739 0802
FAX: (852) 2739 6428

CANON AUSTRALIA PTY. LTD.
1 Thomas Holt Drive, North Ryde, Sydney
N.S.W. 2113, Australia

Info-Line: (02) 9805 2864

CANON NEW ZEALAND LTD.
Fred Thomas Drive, Takapuna
P.O. Box 33-336, Auckland, New Zealand

Info-Line: 0900-522666

ADOBE SYSTEMS INCORPORATED
http://www.adobe.com

ARCSOFT, INC.
http://www.arcsoft.com

SCANSOFT, INC.
http://www.scansoft.com
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